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CHAPTER 1: INSTALLATION, INTRODUCTION, GETTING STARTED

About Leaders

LEADERS is a software program that allows you to enter all filing transactions (contributions, expenditures, etc.)
on-line. After you enter the information, LEADERS then creates all necessary forms and files for electronic filing with
the click of a mouse.

The Louisiana Board of Et hics is pleased to announce the release of LEADE RS (Louisiana Ethics Administration
Disclosure & Electronic Reporting System) version 2.0. This version contains many features designed to expedite the
filing process such as the ability to print validation results, Internet filing and direct dial-up filing.

An important new feature is the Digital Encrypted Password system being implemented by the Louisiana Board of
Ethics. Filers may choose to send their reports to the Louisiana Board of Ethics through TCP/IP (Internet access) or
via a direct dial connection (modem). The filer will n eed to complete an electronic filing affidavit and establish a
password that will be transmitted to the Louisiana Board of Ethics along with the encrypted file and the filer’s
Louisiana Board of Ethics Identification number. In order to take advantage of Internet or direct dial-up filing, you
must obtain a password from the Louisiana Board of Ethics. To obtain a password, call the Louisiana Board of Ethics
Electronic Filing Office at (225)219-5600 or at (800) 842-6630.

About This User’s Guide

This user’s guide contains detailed information about using LEADERS for Microsoft ® Windows ™.
TECHNICAL SUPPORT

If you have any questions or problems with the installation or use of LEADERS, please contact the Louisiana Ethics

Telephone: (225) 219-5600 or (800) 842-6630

Fax: (225) 381-7271
Email: ethics.louisiana@la.gov
Web site: httn://www.ethics.state.la.us

Administration Technical Support Staff.

INSTALLING THE PROGRAM

Diskettes:

> Please note that diskettes are numbered on the back with the LEADERS Version number and Disk Number.

> The Files in the program disk are compressed which means that you can’t just copy them to your hard disk
drive. You must use the Setup program. Follow the Windows 98, 95 or NT 4.0 Installation Instructions

below .
Download from the Internet:

> Go to the Board of Ethics website at http://www.ethics.state.la.us/




The “ReadThis” File

Please review the information in the ReadThis file (if present) on the program disk. The ReadThis file may
contain changes that have been nmade since this user’s gude went to press, including revisions to the installation
procedures. Do not worryif the ReadThis file is not present in your version. This sinply means that there have
been no revisions to this user’s guide since publication.

WINDOWS 98, WINDOWS 95 OR WINDOWS NT 4.0 INSTALLATION

To install LEADERS, choose “Start” then “Run” fromthe Windows task bar. In the dialog box, type “A:setup”
and press return. It is usually best to accept the de fault prompts during the installation process. After
installation, a separate Start Menu Program Item appears called, “Louisiana Applications” (if you accepted the
default prompts). This will contain the new version of LEADERS.

STARTING THE PROGRAM

Now that you’ve successfully installed LEADERS, you wll see that an application group (foWindows) called
Louisiana Applications has been created. Open (by double clicking) the Louisiana Applications icon. (In

Windows 95, you may use the Start Menu to locate andtart the program in the Louisiana Applications folder).
The LEADERS program icon appears, and you may double click on it to open it. For infornmation on the next
steps to start using LEADERS, please see GETTING STARTED and CREATING THE REPORT later in this
chapter.

NOTE: Optimal viewing conditions are met by setting your monitor resolution to 800 X 600, if your system

is not capable of meeting these standards, or you experience difficulty viewing certain screens and/or buttons
within the LEADERS program, please contact technical support at (800) 367-5110.

NAVIGATING THROUGHOUT LEADERS

NAVIGATIONAL BUTTONS

You will use these navigational buttons to select from at the bottom of the forms screens:

Button Command

First Displays the first entry made.

Prior Displays the entry one prior to the current entry being viewed.

Next Displays the next entry following the current entry being viewed.

Last Displays the last entry made.

Edit Activates the current screen to allow editing.

Add Clears data fields in the current view in order to enter a new transaction or list item. You may also clear
data fields to add a new activity by clicking the Next button until the fields are blank.

Delete Removes the current information being viewed.

Save Saves all changes.

Revert Discards changes and reverts to original values.

Browse Displays the browse list (contains al/l previously entered items for this “type” of entry). In a browse list

you may navigate with the arrow keys, highlight an item and press Enter to select it or press the Esc key to
close the list without selecting.

Exit

Exits the current window.




Tab Key

The tab key moves the cursor from field to field within a screen. The Tab key is very useful for moving
around a screen while entering data. Press Shift + Tab together to move the cursor in reverse to the
previous field.

Selecting From a Drop Down List

Some LEADERS windows feature a drop down list. These menus have pre-listed selections to choose
from. To select from a drop down menu, click your mouse on the arrow located within the right margin of
the field. You can quickly locate a selection by scrolling the selections or by entering the first few letters of
the selection. Highlight the selection and hit Enter.

Selecting From a Scrolling Menu

Within any window there may be a scrolling bar option that runs along the right margin. This is indicating
that you are only viewing a portion of the field. You must scroll to up or down to see all of the field’s
options/information.

There are three ways to operate the scrolling menu bar:

> Click your mouse on the upper or lowermost arrow on the bar. Each click will move the page one
line in the corresponding direction.

> Click the mouse inside the “gray” margin area between the upper and lower arrows. Depending on
which side of the “current marker” you click on, the page will move up or down one screen from
your current view.

> Place the pointer on the “current marker” that lies within the gray area between the upper arrows.

Click your left mouse button and %old it down while you “drag” the current marker with the
pointer in either direction. Your screen view will move in the direction that you drag the marker.

Status Bar

The Status Bar, found at the bottom of your screen, displays useful program information and directions.



File Menu

Option Command

New Filing Creates a new, blank file. See SETTING UP A FILER FOR DETAILED INFORMATION.

Open Opens an existing filing. Simply highlight the filer you want to open and click the Open button.
Names Displays every entity related to the filer through itemizations and “Names” entries. See NAMES -

INFORMATION for detailed information.

Auto Calculate Aggregates

Allows user to initiate automatic calculation of aggregates within the specified coverage period.

Recalculate Aggregates

Allows the user to update aggregates at any time within the specified coverage period.

Log-in Brings up the “Log-in Dialog Box”. You can Log-in by following these steps:
> From the File Menu, Choose the Log-in option.
> In the Name box, type ADMIN
> In the Password box, leave it blank.
> Click OK.

Change Password Allows the user to change the password. You can change the password by following these steps:
> From the File Menu, choose the Change Password option.
> In the User Name box, type your User Name.
> In the Old Password box, type your current password.
> In the New Password box, type your new password.
> In the Re-enter Password box, type your New password again for confirmation.
> Click OK to change password, or click Cancel to abort with no changes.

Change User Name Allows the user to change his or her User Name. You can change the name by following these steps:
> From the File Menu, choose the Change User Name option.
> In the User Name box, type your User Name.
> In the New User Name box, type the new user name.
> Click OK to change user name, or click Cancel to abort with no changes.

Utilities Back-up: Creates a copy of the current filer data in a zip (archive) format, and allows you to save it
under the directory of your choice. Periodic “Back-ups” are recommended so that your data can be
salvaged should any problems arise.
Restore: Recreates the filer data from previously backed-up data. It is important that you record the
directory under which you originally backed up your filer data, so that it can be retrieved easily.
Reindex: Automatically compacts and resorts data.

Calculator Displays the Calculator Window.

Disable Sound Disables program sound. When selected, no sound indicators are heard.

Enable Sound

Enables program sound. When selected, you will hear all indicators with sound.

Exit Closes the LEADERS application and resets the system to defaults.
Edit Menu

Option Command

Undo Reverses the last action.

Redo Repeats the last action.

Cut Removes the current selection.

Copy Copies the current selection.

Paste Inserts the last cut or copied selection.

Clear Clears (deletes) selected text.

Select All Selects all text within the active area.




Help Menu

The Help Menu accesses the on-line help, as well as general information about the program.

GETTING STARTED

Before Using LEADERS

To make entering your data into LEADERS as easy as possible, you should have the following items:

> All relevant records and information such as bank statements, contributions and other receipt
records, loan information, and prior reports, if applicable.
> A cash on-hand balance amount, if you are a continuing campaign/committee.

If you are a continuing campaign/committee and wish to start the program showing all year-to-date
information, you must enter all year-to-date totals for all entities in a reporting period prior to the current
period.

If you wish to start this program at the beginning of a new reporting period, without cumulative totals, you
can start only with your cash on hand.

Setting up a Filer

When you open LEADERS for the first time to add your filer to the system, select the “New Filing” option
from the File Menu. The “New Filing” window appears.

In this “New Filing” Screen you will enter the following information:

> Unique 6 character name for this filing - This is your personal identifier for the filing. For
example, if you were entering a filer for the “Public for Progress Political Action Committee”, you
might simply refer to it in the identifier as “PFPPAC”. Remember, the identifier should be unique
for your own personal ease of use.

> Filing Type - Select Political Committee (PAC) from this drop down list.
> Filing/Committee Name.- Enter the name of the committee.
> Identification Number - This is the identification number assigned by the State of Louisiana for

this filer.



Names - Information

The “Names” window has two tabs at the top labeled Data Entry (for entering a new entity) and List
which displays every entity related to the filter through itemizations and “Names” entries.

You can efficiently construct a new entity by selecting the Names option from the Filer Menu. Enter the
following information:
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Field Explanation
Name ID The system automatically numbers each entry.
Type Select the Entity Type by using the drop down menu. Highlight one of the following Entity Types:
> Individual > Political Committee (PAC) > Other Officer
> Legal Entity > Principal Campaign Committee > Preparer
> Lobbyist > Subsidiary Campaign > Ballot Measure
> Candidate Committee Sup/Opp
> Candidate Beneficiary » Chairperson > Anonymous
> Financial Institution > Treasurer > Real Estate Holding
> Deputy Treasurer
Mr./Ms. If entity is a person, enter a prefix of Mr. Or Ms.
Last Name or Enter one of the following depending on the type of filer:
Organization > Last Name, if the entity is an individual; OR
> Name of Organization, Business, Committee, etc.
Address Enter the address of the filing entity.
City Enter the city, for the address, of the filing entity.
State Enter the two-letter state code, for the address, of the filing entity.
Zip Enter the zip code + 4, for the address, of the filing entity. (The +4 is optional)
Phone Enter the entity’s main telephone number (optional).

Note: After you have entered an entity into the system, they are available to browse for selection.
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SELECTING A PREVIOUSLY ENTERED NAME FROM YOUR DATABASE

LEADERS allows for data entry shortcuts when entering names information within schedules and/or cover
pages. From the various Filing Information Screens, you may select a name from your database using your
TAB key, and all of the information for the selected individual/organization will be transferred to the current
data entry fields.

For example, rather than re-entering all relevant information for a contributor within a schedule or cover
page, simply:

> select edit

Schedule D | Schedule E-1 | Schedule E-2 | Schedule E-3 | Schedule E-4 | Schedule F | Summary |

. cpe s .
if it isn’t there already,. Cover Page |l | Schedule A1 | Schedule A-2 | Schedule A-3 | Schedule B | Schedule ©
make sure your cursor 18

in the Name field. Filer 1D |123123

Mame and Address of Political Commitiee I G ommmitte U ppomting ticket of & political pady

> Press the Tab key from
within this field and you
will be prompted by the Address
Names listing of each |
entry in your databage oty |
ts}é;lslfi;ri:ﬁ Ezyﬁ:ltther State l_ Zip l-— = CheckifAmendrment o pricr report
using your arrow keys, or

MName ITest Committee

Marne of the political party

with your mouse pointer Drate of Primary Covers from thiru Type of Repart
to locate your selection. I 4o/ I ;oY I Ao IlSU days prior to Primary j
> Press Enter on your

First | i | [Est | L&t | Eciit | Al |Qelete| SEVE |Eever1 |ﬂrowse| Exit |

keyboard, and

information for your
i i
selection will ol [ B

1 Last or Business Name First Address1 B
automatically transfer to !_Test

the schedule or cover
page for which you are
currently providing
information. This action
may be repeated as often
as necessary.




CHAPTER 2: THE INSTRUCTIONS WINDOW
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The Instructions Window contains “Task” selections along the left margin, and the “Forms” list in the right

margin.
TASKS

You may select one of the following Tasks by clicking
your mouse on the co rresponding button, then click
<<Next>> to enter the edit windows.

Instructions

Choose the task
yau would like to

@ Form 100 -
@ Form 101 -

petform and click  Form 102 -
Mext... @ Form 1032 -
= @& Farm 104 -
= © Form 200 -
e 3

Click here to entar Form 201
 Form 202 -

filing informatian.

[y

Click here to print &
preview report.

 Form 203 -
7 Form 204 -
 Form 205 -
@ Form 400 -

@ Form 401
% Form 402 -
@ Form 403 -
Click here to & Form 500 -
electronically file
el @ Form 501 -

@ Form 502 -

Diesignation of PrincipaliSubsidiary Committee
Candidate's Affidavit in Lieu of Report
Candidate's Report

Candidate's Special Report
Candidate's Election Day Expenditures
Statement of Organization

Committee's Affidavit in Lieu of Report
Committee's Report

Committee's Special Report
Committee's Election Day Expenditures
Statement of Dissalution

Fersanal Einancial Dizclosure Farm

- Gaming Contral Board FDS

LEA-R.8. 39:1233.1 Disclosure Statement
LSA-R.8. 42111598 Disclosure Statement Pursuant
Lobhbvist Registration

Lobhyist Supplemental Registration

Lobhyist Expenditure Report

Help |

Click next to continue

Mext == |

Filing Information

Select this button to enter your filing information.

All of the information regarding your filer and filing
data is available when the filing information task
button is selected. See FILING INFORMATION for more
detailed information.

Print & Preview Report

Select this button to preview the active file report.
After you have previewed the report, you can select
to send the report to your printer.

LAPrint™ is a printing and previewing utility that
will first show the report graphically (as it will appear
when printed), then give the option of printing the

report. See PRINT & PREVIEW REPORT for more detailed

information.

Electronically File Report

Select this button to electronically file your completed
report to the Louisiana Board of Ethics via the Internet
or modem.

LALoad™ provides filers with the convenience of being

able to submit disclosure filings electronically. See

ELECTRONICALLY FILE REPORT for more detailed information.

CHAPTER 3: FILING INFORMATION
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FORMS AND FORM ENTRY INSTRUCTIONS

You will see that each form selection has a circle in front of the formtitle. Those circles that are “grayed out”
cannot be selected because they do not pertain to youtfiling type”. Therefore, click your nouse on the “white
circle” of the selection you want to go to which willm  ark it witha “dot”. After you have m arked the
appropriate form, click on the <<Next>> button in the bottom right corner of the Instructions Window. You
will be taken to the window that contains data fields where you can now enter the information for the type of
itemization you have selected.

SELECTING THE APPROPRIATE FORM & SCHEDULE

Use the following chart to cross reference the type of transaction with the appropriate form and schedule.

Transaction Type Form/Schedule
General Contribution 202/A-1
General In-kind Contribution 202/A-2

Other Receipt 202/A-3
General Expenditure 202/E-1
General In-kind Expenditures 202/E-2
Contribution made to a Candidate 202/E-3

Other Disbursement 202/E-4
Contribution from Political Committee 202/A-1

In-kind Contribution from Political Committee 202/A-2
Proceeds from sale of fundraiser tickets 202/A-1
Proceeds from sale of Campaign Paraphernalia 202/A-1 or Summary Page
Expenditure from petty cash fund 202/E-1
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FORMS AND SCHEDULES - INFORMATION AND INSTRUCTIONS

Form 200: Statement of Organization
General Information - Statement of Organization

A $100 filing fee must accompany the Statement of Organization. The fee should be paid with a committee
check payable to “Campaign Finance.” The form may be electronically filed, but the check must be hand
delivered or mailed no later than the next working day followinghe due date of the Statement of Organization.

This form must be filed every year between January 1 and January 31, subject to the following exceptions:

> If a committee organizes after January 31, then this form must be filed within 3 days of the date of
organization.

> If the committee organizes within 10 days prior to an election, then this form must be filed within 3
days of the date of organization

> If the committee does not anticipate that it will have over $500 in total financial activity for a

particular calendar year, it is not required to file this form for that year. If it determines later in that
year that it will exceed $500 in total financial activity, then this form must be filed within 10 days.

A Certificate of Registration will be issued to each properly organized committee.

A committee that has over $500 of financial activity in a calendar year and does not file a Statem  ent of
Organization is subject to fines.

Mail or hand deliver the required fee to:
CAMPAIGN FINANCE
P. O. Box 4368
Baton Rouge, LA 70821

Instructions - Form 200 (Always click “Edit” to activate a screen)

1. Enter the name and address of the com mittee. Committee names must comply with the following
rules:
> The name cannot be the sam e as or deceptiv ely similar to the nam e of another politic al
committee.
> If the committee supports only one candidate, the committee name must contain the name
of that candidate.
> If the committee supports only one candidate, the committee name cannot contain the name

of an individual unless the com mittee name clearly reflects that the committee is not
supporting or opposing only that individual.

> If the committee uses an acronym in addition to its com plete name, place the acronym in
parentheses after the complete name.
> If the committee name contains a number, spell out the number in the name and place the

numerical symbol(s) in parentheses.

2. Enter the date the Statement of Organization is completed. Enter a check if this is the first year the
committee has registered.

3. Enter the estimated number of members the committee anticipates it will have this year. Check if the
committee has over 250 members who contributed over $50 to the committee during the preceding
calendar year. Meeting this membership requirement allows the committee to contribute double the
contribution limit to candidates.

4. Check “Yes” if this filing is an am endment to a previously filed Statement of Organization. Any
change in the information reported on this formthat occurs before the conmittee’s next Statement of
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Organization is otherwise due must be reported byfiling an amended Statement of Organization within
10 days following the change. No filing fee is required for the filing of such an amendment.

5. Right click on the grid and entethe information with regard to all conmittee officers and/or directors:
a. Enter the full name of each officer/director.
b. Enter the complete address of the officer/director.
c. Enter the position of the officer/director (e.g. Chairperson, Treasurer).

6. Enter the necessary information with regard to avy affiliated organizations. An affiliated organization
is any organization, other than a political c =~ ommittee, which directly or indirectly established,
administers or financially supports this committee.

a. Enter the full name of each affiliated organization.
b. Enter the complete address of each affiliated organization noted in 6a.
c. Enter the relationship of the affiliated organization to the political committee.

7. Enter the necessary information for all depositories for committee funds. NOTE: Committee funds
must be deposited in one or nore banks, savings and loans institutions or noney market mutual funds.
a. Enter the full name of each depository.
b. Enter the complete address of each depository.

8. Indicate whether this committee supports a single candidate by checking “yes” or “no”. IfNo, go to
Item 9. If Yes, there must be a Statement of Designation (Form 100) completed by the candidate or
his principal campaign committee for this committee already on file or accompanying this form. If
this committee will be supporting a candidate:

a. Check whether the committee will be designated as the principal campaign committee or a
subsidiary committee; check whether the committee will support or oppose the candidate;

b. Enter the candidate’s qualifying name;

c. Enter the office sought by the candidate.

9. a. Enter the full name of the person preparing the Statement of Organization.
b. Enter a daytime telephone number where this person may be contacted during business hours.

10. Complete date of certification and all required signatures and telephone numbers.

Form 201: Committee’s Affidavit in Lieu of Report

General Information - Committee’s Affidavit in Lieu of Report

This form should be used ONLY if the committee meets ALL of the following criteria:

1. Contributions from one source in excess of $200 have not been received during the calendar year;
2. Expenditures in excess of $5,000 have not been received during the calendar year;
3. An itemized (long) report has not been filed during the calendar year.

THIS AFFIDAVIT MUST BE SWORN BEFORE ANOTARY. AFFIDAVITSFILED ELECTRONICALLY
MUST THEREFORE BE SUBMITTED IN ORGINAL FORM BY MAIL OR HAND DELIVERED BY THE
NEXT WORKING DAY AFTER THE DUE DATE OF THE REQUIRED REPORT.

Instructions - Form 201
1. Enter full name and address of the committee.

2. Enter the date of the election. If the election date is not yet known, enter the anticipated year of the
election. Additionally, enter the date of the report and the period the report is covering.
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3. Select the type of report the committee is filing by choosing from the drop down list.

4. Right click on the grid and:
a. Enter the full name of the person preparing the report.
b. Enter a daytime telephone number where this person may be contacted during business hours.

5. Complete the certification by having the signature of the committee chairperson notarized.

Form 202: Committee’s Report
General Information - Committee’s Report

All transactions must be reported, regardless of amount. Exception: In-kind transactions valued at $25 or less
are not required to be reported. However, successive trasactions must be added together to deternine whether
$25 has been exceeded.

A committee bank account must be maintained. All contributions must be deposited in the account. All
expenditures must be made by check drawn on the account. The check m ust be made payable to a specific
person and indicate the object or services for wh ich it was drawn. Exception: A petty cash fund m ay be
maintained and used for expenditures of $100 or less that are not for personal services.

Cash contributions to the committee in excess of $100 from one source during a calendar year are prohibited.
A cash contributor must be given a receipt containing hs name, address, social security number and signature,
as well as the date and exact amount of the contribution. The committee must keep a copy of the receipt.

A record must be kept for every transaction, including the sale of tickets to fundraising events. The sale of a
ticket to a fundraising event is reported as any other contibution. Exception: In the case of asingle transaction
involving the sale of campaign paraphernalia for $25 or less, no record need be kept except the total amount
received and deposited and the fact that such amunt was received from such sale. The total amount is reported
on Line 3 of the Summary Page.

Contributions to candidates are subject to the followng limits per election: $5,000 for major office candidates,
$2,500 for district office candida tes, and $1,000 for any other office candidates. Major office candidates
include offices elected statewide, public service commissioners, supreme court justices, and offices electedin
a district containing a population in excess of 250, 000 according to the m ost recently published decennial
federal census. District office candidates includeegislative offices, offices elected parishwide or in nore than
one parish, and offices elected in a district having a popultion in excess of 35,000. Any other offices arethose
offices which are not major or district.

The primary and general elections are considered twoseparate elections. When calculating whether the limits
have been reached, outstanding loans, endorsements or guarantees on loans, and contributions must be added
together. The limits do not apply to contributions made by recognized political parties or their committees.
The limits may be doubled when the contributor is a political com mittee with over 250 m embers who
contributed at least $50 to the com mittee during the preceding calendar year. The com mittee must have
certified that it neets this membership requirement on its annual Statement of Organization and the conmittee’s
annual report must reflect that it is eligible to make this certification. Further, the committee must notify the
candidate in writing at the time of the contribution that it has met the certification.

Separate reporting forms are to be used for “Special Reports™ and “Election Day Expenditures.”

Contributions or loans in the name of another are prohibited. If funds are made available to a committee by
a person who has loaned those funds by a third party, the name of the third party must also be disclosed.
Expenditures made by a public relations firm , an advertising agency or agent for the com mittee must be
reported to the com mittee; the ultimate recipients of any such expenditures are required to be reported on
Schedule E-1 of this report.
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Expenditures, including any reim bursement of costs to persons in order to transport voters to the polls are
prohibited. Exception: such expenditures are allowedf made to a bona fide bus, taxi, or transportation service,
which holds a license or permit duly issued by the appropriate governmental entity.
A copy of this report should report be m aintained for the com mittee records. Committee records must be

preserved for six years.

Instructions - Form 202 (Always click “edit” to activate a screen)

Cover Page
1. Enter the full name and address of the political committee.
2. If the committee is supporting the entire ticket of a political party, place a check in the box next to

Committee supporting the ticket of a political party, and in the space provided, indicate which party.

3. Enter the date of the election and report coverage dates. The date of the el ection must be included
unless this is an annual report.

4. Choose the type of report the committee is filing from the drop down list.
Cover Page II
5. Right click on edit and list the nam e, position and address of each of the com mittee’s officers

including Chairperson, Treasurer, if any, and any other committee officers. Also, enter the name of
the person preparing the report and a daytime phone number.

6. Enter the requested inform ation for candidates or propositions the com mittee is supporti ng or
opposing. If the com mittee has supported or opposed a proposition or ballot issue duri  ng the
applicable reporting period, a description of the proposition should be included along with a
designation of whether it was supported or opposed.

7. Complete the certification with thedate the report is being filed and the signatures of the conmittee’s
chairperson and the treasurer, if any.

SCHEDULE A-1, FORM 202: CONTRIBUTIONS RECEIVED (OTHER THAN IN-KIND
CONTRIBUTIONS)

The required information must be provided for all contibutions received by the committee during this reporting
period, except for in-kind contributions, whether received froma political committee or some other person or
entity. Contributions made by the committee are reported on SCHEDULE E-3: CONTRIBUTIONS MADE
TO CANDIDATES. Inform ation on in-kind contributions is reported on SCHEDULE A -2: IN-KIND
CONTRIBUTIONS. For anonymous contributions, sse SCHEDULE F.

1. Enter the name and address of each contributor.

2. Choose the receipt type from the drop down list.

3. Enter the date of the contributor’s contribution.

4. Enter the amount of the contributor’s contribution.

5. Enter the total contributions made during this election by the contributor unless you have selected

“Auto Calculate Aggregates.”
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6. If the contributor is a political committee, check the box with that option.
SCHEDULE A-2, FORM 202: IN-KIND CONTRIBUTIONS RECEIVED
The required information must be provided for all in-kind contributions received by the conmittee during this

reporting period. In-kind contributions m ade by the committee (i.e. in-kind expen ditures) are reported on
SCHEDULE E-2: IN-KIND EXPENDITURES. For anonymous contributions, sse SCHEDULE F.

1. Enter the name and address of each in-kind contributor.

2. Enter the date of the contributor’s in-kind contribution.

3. Enter the value of the contributor’s in-kind contribution.

4. Enter the total in-kind contributions from this contributor for this election unless you have selected

“Auto Calculate Aggregates.”
5. If the contributor is a political committee, check the box with that option.

6. Enter a brief description of the in-kind contribution.

SCHEDULE A-3, FORM 202: OTHER RECEIPTS

Use this schedule to report those receipts that are not‘contributions”; that is, monies received by the conmittee
that are not paid to it for the purpose of supporting, opposing or otherwise infl uencing the nomination or
election of candidates to public office or supporting or opposing propositions or questions subm itted to the
voters. Examples include interest or investment income. Receipts should be reported onthis schedule only if
they have not been reported elsewhere inthis report. The explanation of the receipt should state the reason the
payment was made to the committee.

1 Enter the name and address of each source.
2. Enter the date and amount of the receipt.
3. Enter a brief explanation of the receipt.

SCHEDULE B, FORM 202: LOANS RECEIVED

The required information must be provided for each loan or line of credit received this reporting period, even
if it has been repaid. Also, conplete this schedule for loans received in prior periodsthat are still outstanding.
Separate loans must be reported separately, even if from the same source.

1. Enter the name and address of the lender.
2. Enter the date of the loan. For lines ofcredit, give the date the line of credit was first conmitted.
Enter the interest rate.

Enter the amount borrowed. For lines of credit, list only the amount actually drawn.

Enter the balance due.

OPTIONAL - Total amount of credit available. For lines of credit, you may list the total amount
of credit available if you wish.

oao o

3. Right click on the grid and enter the full nane and address of each person or entity that has endorsed,
guaranteed or otherwise secured the loan or line of credit. Also, state the anount of liability for each
endorser or guarantor.

4. Repayments this period. Right click on the grid and:
a. Enter the date of repayment.
b. Enter the amount of principal included in this repayment.*
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c. Enter the amount of interest included in this repayment.*

*  List payments of principal and interest separately. If separate amounts are not known, list all
payments under principal.

SCHEDULE C, FORM 202: DEBTS AND OBLIGATIONS (OTHER THAN LOANS)

Use this schedule to report either debts owedby the committee or debts owed to the committee, clicking on the
appropriate circle at the top of the form If the campaign has experienced both types of debts, then report them
separately. Never combine debts owed by and debts owedto the committee. Debts should be reported on this
schedule until repaid. When repayments are made by the committee a corresponding entry should be nade on
SCHEDULE E-1: GENERA L EXPENDITURES. W hen repayments are received by the com mittee a
corresponding entry should be made on SCHEDULE A-3: OTHER RECEIPTS.

Click the appropriate circle as to whether this is “owed by” or “owed to” the committee.

1. Enter the name and address of the debtor or creditor.

2. Enter the outstanding balance beginning this period.

3. Enter any amount(s) incurred this reporting period.

4. Enter any payment(s) made this reporting period.

5. If you are reporting a debt, enter the reason the debt was incurred in the space provided.

SCHEDULE D, FORM 202: FUNDS LOANED

The required information must be provided for each loanmade by the committee this reporting period, whether
made to candidates or others, with com mittee funds, even if the loan has been repaid. Also, co mplete this
schedule for loans made in prior periods that are still oustanding. Separate loans must be reported separately,
even if the loans are made to the same borrower.

1. Enter the name and address of the borrower.
2. a. Enter the date of the loan. For lines of credit, enter the date when the line of credit was first
committed.

b. Enter the interest rate.
c. Enter the amount loaned. For lines of credit, enter only the actual amount drawn.
d. Enter the balance due.

OPTIONAL - Total amount of credit available. For lines of credit, you may enter the total amount
of credit available if you wish.

3. Right click on the grid and enter the full nane and address of each person or entity that has endorsed,
guaranteed or otherwise secured the loan or line ofcredit. Also, state the anount of liability for each
endorser or guarantor.

4. Repayments this period. Right click on the grid and:
a. Enter the date of repayment.
b. Enter the amount of principal included in this repayment.*
c. Enter the amount if interest included in this repayment.*

*  List payments ane interest separately. If separate amounts are not known, list all paynents under
principal.
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SCHEDULE E-1, FORM 202: GENERAL EXPENDITURES

Use this schedule to report information on most committee expenditures during this reporting period, except
(1) in-kind expenditures, and (2) expenditures to candidates or their committees which should be reported on
SCHEDULES E-2 and E-3 respectively. They should notbe reported on this schedule. An “expenditure” is
any payment made for the purpose of supporting or opposing the election of a candidate for public office or
supporting or opposing a proposition or question submitted to the voters. Expenditures include monies spent
for the committee’s general operating expenses. Any payments made that are not “expenditures” should be
reported on SCHEDULE E-4: OTHER DISBURSEMENTS.

1. Enter the name and address of the recipient.

2. Enter the date of the expenditure.

3. Enter the amount of the expenditure.

4. Place a check in the box if the expenditure was from petty cash.

5. Enter the purpose of the expenditure. Ifthe expenditure directly benefitted a particular candidate(s),

list the candidate(s)’ name where indicated.

SCHEDULE E-2, FORM 202: IN-KIND EXPENDITURES

The required information must be provided for all in-kind expenditures made by the committee, during this
reporting period. In-kind contributions received bythe committee are reported on SCHEDULE A-2: IN-KIND
CONTRIBUTIONS RECEIVED.

1. Enter the name and address of the recipient.
2. Enter the date of the in-kind expenditure.
3. Enter the purpose(s) of the in-kind expenditure. If the expenditure directly benefitted or was made

on behalf of a particular candidate(s), list the candidate(s) name(s).

SCHEDULE E-3, FORM 202: CONTRIBUTIONS MADE TO CANDIDATES

The following information must be provided for direct contributions m ade to candidates or th eir campaign
committees during this reporting period, except for in-kmd expenditures. All candidates listed orthis schedule
should also be listed on the Cover Page as candida  tes supported by the com mittee. Report all in-kind
expenditures, including those made to candidates, on SCHEDULE E-2: IN-KIND EXPENDITURES.

1. Enter the name and address of the recipient candidate.
2. Enter the date of the contribution.
3. Enter the amount of the contribution.

SCHEDULE E-4, FORM 202: OTHER DISBURSEMENTS

Use this schedule to report those disburse ments that are not “expenditures”; that is, m onies paid by the

committee that are not paid for the purpose of supporting, opposing or otherwise influencing the nomination
or election of a candidate to public office or supporting/opposing a proposition or question submitted to the
voters. Examples include the paym ent of taxes or the refund of contributions. Disbursem ents should be
reported on this schedule only if they have not been reported elsewhere in this report.
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1. Enter the name and address of recipient.

2. Enter the date of disbursement.
3. Enter the amount of disbursement.
4. Enter the description of the disbursement. The description should state the reason the payment was

made by the committee.

SCHEDULE F, FORM 202: ANONYMOUS CONTRIBUTIONS

Anonymous contributions must be transmitted to the State — They cannot be kept or used. On this schedule,
state the date and amount of each anonymous contribution received during this reporting period, as well as the
date that each contribution was transm itted to the State. Receipts from the sale of campaign paraphernalia
(items such as political campaign pins, buttons, hats, T-shirts, bumper stickers, literature, etc.) in transactions
of $25 or less are not considered anonymous contributions.

Anonymous contributions should be mailed to the Treasurer of the State of Louisiana, accompanied with an
explanation that the check represents an anonymous contribution and is forwarded pursuant to LAS-R.S.
18:1505.2B.

1. Enter the date the anonymous contribution was received.

2. Enter the amount of the anonymous contribution.

3. Enter the date the anonymous contribution was transmitted to the State.
SUMMARY PAGE

For Summary Page entries, each lineis auto-calculated based on entries made into the systemunder the various
schedules with the exception of lines 3, 19 and 20. Information for each of these three lines should be entered
manually.

Line 3: Campaign Paraphernalia sales of $25 or less

Line 19: Of funds on hand at beginning of reporting period (Line 14 above), amount held in investments

Line 20: Of funds on hand at close of reporting period (Line 18 above), amount held in investments
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Form 203: Committee’s Special Report
General Information - Committee’s Special Report

This form is filed during the 20 day period immediately preceding an election to report (1) all receipts from a
single source in excess of $500 by com mittees supporting major office candidates, or in excess of $250 by
committees supporting district or any other office candidates, and/or (2) any payments exceeding $200 to any
person who endorses candidates and who is required to file cam paign finance disclosure reports. All
committees who have had any such transactions within the 20 days im mediately preceding an election are
required to report any such transaction on this form within 48 hours of the time the transaction occurred.

Instructions - Form 203 (Always click “Edit” to activate a screen)
Cover Page

1. Enter the complete name and address of the political committee. Acronyms should not be used. An
acronym may be specified in parentheses following the complete name.

2. Indicate whether this report is for the primary or general election by clicking on the appropriate circle.
Specify the date of the election

3. Specify a range of dates during which informtion should appear for this report. Information will only
appear on this report that falls on dates specified within this range.

4. Enter the date the report is conpleted/certified. Complete certification by including the signatures of
the committee’s chairperson and treasurer with their respective telephone numbers in the appropriate
spaces. If the form is filed electronically, a typed signature is adequate.

Cover Page I1

5. Right click on the grid and enter the nam e and daytime telephone number of the pe rson who is
preparing this report. Also, enter the name and address of the committee chairperson.

SCHEDULE A, FORM 203: CONTRIBUTIONS RECEIVED (INCLUDING IN-KIND
CONTRIBUTIONS)

COMMITTEES SUPPORTING MAJOR OFFICE CANDIDATES:The required information must be reported
for all contributions and in-kind contributions exceed ing $500 received during the last 20 days before the
primary election, as well as those received in the last 20 days before the general election if the com mittee
participates in the general election.

COMMITTEES SUPPORTING D ISTRICT OFFICE CANDIDATES AND ANY OTHER OFFICE
CANDIDATES: The required inform ation must be reported for all contributions and in-kind contributions
exceeding $250 received during the last 20 days before the primary election, as well as those received in the
last 20 days before the general election if the committee participates in the general election.

6. Enter the name and address of the contributor.
7. Select the type from drop down list.

8. Enter the date of contribution.

9. Enter the amount of contribution.

10. Enter the valuation of in-kind contribution.

11. Enter a description of in-kind contribution.
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SCHEDULE B, FORM 203: LOANS RECEIVED

COMMITTEES SUPPORTING MAJOR OFFICE CANDIDATES: The required information must be reported
for all loans of more than $500 received during the last 20 days before the primary election, as well as those
received in the last 20 days before the general election if the committee participates in the general election.

COMMITTEES SUPPORTING DISTR ICT OFFICE CANDIDATES AND ANY OTHER OFFICE
CANDIDATES: The required information must be reported for all loans of more than $250 received during
the last 20 days before the primary election, as well as those received in the last 20 days before the general
election if the committee participates in the general election.

1. Enter the name and address of the lender.
2. Enter the date of the loan.
Enter the interest rate.
Enter the amount borrowed.

Enter the balance due.
OPTIONAL: Enter the amount of credit available if a line of credit.

o a0 o

3. Right click on the grid and enter the fullhame and address of each person or entity that has endorsed,
guaranteed or otherwise secured theloan or line of credit. Also, state the anount of liability for each
endorser or guarantor whose liability is less than the entire amount.

SCHEDULE C, FORM 203: EXPENDITURES TO THOSE WHO MAKE ENDORSEMENTS

Use this schedule to report canpaign expenditures in excess of $200 during the last 20 days before the prinary
or general election if th e committee participates in the general election and ism ade to any person or
organization that makes endorsements of candidates who are required to file campaign finance disclosure
reports.

1. Enter the name and address of recipient.
2. Enter the date of expenditure.
3. Enter the amount of the expenditure and a brief description if in-kind.

Form 204: Committee’s Election Day Expenditures Report

General Information - Committee’s Election Day Expenditures Report

This report is required to be filed by all com mittees participating in an election, even if no el ection day
expenditures were made. The report is due not later thad 0 days after the prinary election, and, again, not later

than 10 days after the general election if the committee participates in the general election.

NOTE: This report is required in addition to all other required reports. Therefore, the expenditures reported
on this report must be reported in subsequent “Committee’s Reports” for this election.

Instructions - Form 204 (Always click “Edit” to activate a screen)

1. Enter the full name and address of the political committee.
2. Click on the appropriate circle to indicate whether tis report relates to the primary or generalelection.
3. Specify arange of dates during which informtion should appear for this report. Informtion will only

appear on this report that falls on dates specified within this range.
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4. a. Enter the full name of the person preparing this report.
b. Enter a daytime telephone number where this person may be contacted during business hours.

5. Complete certification with the date the report is being filed and the signatures of the com mittee
chairperson and the treasurer, if any. If the report ifiled electronically, a typed signature is adequate.

SCHEDULE A, FORM 204: ADVERTISING

The required information must be provided for each peron to whoman expenditure was nade for the purchase
of television, radio or newspaper advertising broadcast, or published on election day.

1. Enter the name and address of recipient.

2. Click on the appropriate circle to indic ate whether this expenditure is for the prim ary or general
election and select the year.

3. Indicate the type of advertising by choosing from the drop down list.

4. Enter the date & total amount paid to the recipient.

SCHEDULE B, FORM 204: ELECTION DAY WORKERS

The following information must be provided for each individual to whonan expenditure was nade for services
performed on election day. Also, the infornation must be provided for each individual performng services on
election day to whom a monetary expenditure was made by an organization or which a payment was made by
the committee completing this report.

1. Enter the name and address of recipient.

2. Click on the appropriate circle t o indicate whether this expenditure is for the prim ary or general
election and select the year.

3. The social security number of the recipient is no bnger required. Please leave this field blank. Wen
you file electronically you may receive a validation error similar to this:

EXPN,B 4 014 Conditionally Required field is Empty
'--> Rept_ SSN
'--> Line-item Name: Deaux”Johnny""
You may safely ignore this error.

4. Enter the date & total amount paid to the recipient.

5. Enter the organization making the payment, if applicable.

SCHEDULE C, FORM 204: PAYMENT TO ORGANIZATIONS

The required information must be provided for each organization to which the committee has made payments
for any service(s) performed on election day.

1. Enter the name and address of the organization receiving the payment.

2. Click on the appropriate circle to indicate whethe r this expenditure is for the prim ary or general
election and select the year.

3. Enter the date & amount paid to the organization.

4. Enter the purpose of the payment.
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Form 205: Statement of Dissolution

General Information - Statement of Dissolution

Each political committee, including any subsidiary committee, which after having filed an annual statenent of
organization wishes to dissolve or disband and:

Determines that it has not received any contributions, transfers of funds, or loans and has not made
expenditures, transfers of funds, or loans in the aggregate during the calendar year in excess of five
hundred dollars ($500) and does not anticipate doing so, OR

Determines that it will nolonger receive any contributions, loans, or transfers of fundsand no longer
make any expenditures, loans, transfers of funds and shall file a statem ent of dissolution with the
supervisory committee prior to dissolving.

All committee debts and obligations must be paid or otherwise extinguished and any funds on hand must be
expended or otherwise distributed before a political committee can dissolve.

Instructions - Form 205 (Always click “Edit” to activate a screen)

1.

Enter the full name and address of the political committee as it was designated on the Statement of
Organization. Enter the date of the statement.

Enter the complete name and address of the Committee’s chairperson.

Check whether this committee was the principal campaign committee of a candidate. If yes, then
specify the full name and address of the candidate.

Check whether this com mittee was a subsidiary com mittee designated by either a candidate or a
principal campaign committee. If yes, then specify the full nam e and address of the candidate or
committee.

Complete date of certification and all required signatures and telephone numbers. If this formis filed
electronically, a typed signature is adequate.
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CHAPTER 4: PRINT AND PREVIEW REPORT

In order to run LAPrint™, follow these steps:
Note: A form (report) MUST be selected in order to utilize the Print options.

1. From the Inst ructions Window, Iﬁ

select the Print & Preview button M @ Form 100 - Designation of PrincipaliSubsidiary Committes

:fohu”&iil‘;‘ﬁ;zstg @ Form 101 - Candidate's Afdavitin Lisu of Report
2. The file to be printed will appear T 2 il @ Form 102 - Candidate's Report
. . oF 103 - Candidate's Special Report
as a preview on the screen, in the NE, o 103 - Candidate's Spacis! Repe _
: “f 29 f t & @ Form 104 - Candidate's Election Dav Expenditures
approprlate orms - format. D ¢ Farm 200 - Staternent of Organization

I . . -
Sk e i e Farm 201 - Committee's Affidavitin Lieu of Report

3. From here you may print out the fling infarmation.  Form 202 - Committee's Report
actual forms on paper. Select I :Eormigi-gommf:ws gqeilal F;epo; .
. . arm - Committee's Election Day Expenditures
File, then Print. |

' Form 205 - Staternent of Dissolution

Click here to print &
P & Form 400 - Personal Financial Disclosure Form

preview repor.

4. In the Print Screen, you can @ Form 401 - Gaming Control Board FDS

choose the printer print range @ Form 402 - LSA-R.S. 39:1233.1 Disclosure Statement

B
and the num ber ofc opies to @ Form 403 - L8&-R.5. 4211198 Disclosure Statement Pursuant
. P Click here to @ Form 500 - Lobbyist Registration
pl‘lnt. Once you have seleCted re;zcotrrtonlcallyﬂle @ Form A01 - Lobbyist Supplemental Registration
your OpthIlS, click OK. & Form 502 - Lobbyist Expenditure Report
Help | Click next to continue eyt == |

LAPrint™ Options:

While previewing the file you can zoom in/out, or go to a specific page in the file.

To Zoom

> From the Menu Bar, select View.

> Select the Zoom option.

> Enter a number in the percentage window and select Enter.

To Go To a Specific Page

Use the vertical scroll bar on the right side of your screen to scroll up and down or to view a specific page.
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CHAPTER 5: ELECTRONICALLY FILE REPORT
Filing Upload

> In order to run LALoad™ , follow these steps: (Note: A form {report form} MUST be selected in
order to use the Load options)

1. From the Instructions W indow,
select the Ele ctronically File Instructions e = i :
Report Button - = @ Form 100 - Designation of PrincipaliSubsidiary Committee
Chﬁﬂseltgﬁgastk 5 Form 101 - Candidate's Afidavit in Lisu of Repart
you would like to .
) Click the <<Next>> Butt o th i i ol @ Form 102 - Candidate's Repart
. 1C S X ution 1n the Mest @ Form 103 - Candidate's Special Report
lower right hand corner of the ~ & Form 104 - Candidate's Election Day Expenditures
Instructions Window. The “filer” B € Form 200 - Staternent of Organization
Wﬂl automatically undergo the Click here o enter  Form 201 - Comm?nee's Affidavit in Lieu of Report
LALoad™ verification and file fling inforrnation. € Form 202- Commitiee's Report
¢ Form 203 - Committee's Special Repart
process. Iﬁ  Form 204 - Committee's Election Day Expenditures
AR RE ¢ Farm 205 - Staternent of Dissalution
3. You will be prom pted as to rlecvie\n\?rripoorﬁ.nn @ Form 400 - Personal Financial Disclosure Farm
whether or not your ﬁling passed @ Form 401 - Gaming Contral Board FDS
initial diaenostics. Ifit failed @ Form 402 - LS&-R.S. 3312331 Disclosure Statement
g e ’. @ Form 403 - LSAR.S. 42:11198 Disclosure Statement Pursuant
choose <<Details>> to determine Cllicbtﬁhere tlT . @ Farm 500 - Lobbyist Registration
where in the selected report that reezcmrf”'ca yile 3 Farm 501 - Lobhyist Supplemental Registration
the errors exist, so that you m ay 5 Farm 502 - Lobhyist Expenditure Report

return to the filing information Help | Click nextto continue_ Cancel | Next ”|

screen to make corrections.

The content of the current report is checkedfor completeness and correctness, and the results of this check are
displayed in the Validation Window.

> The first line of the validation output is the “Validation Summary,” followed by a “checksum”.

> If the current report fails validation, the m essages in the Validat ion window should be used to
diagnose and correct the errors.

The following are examples of error messages you may receive:

RecType Err Col

Example Form Type Lvl # Description
#1 CVD,F102 12 007 is Required, but field is Empty

> Rpt_Date

#2 RCPT, A-1 12 005 is Required, but field is Empty
> Address 1
> Line-item Name: P.C.M.

#3 RCPT, A-2 4 009 Zip Code is Invalid or Missing/Zip = 45475
> Zip4
> Line - item Name: Other State Party

You must correct errors with ERR LVL + 8 or greater. Reports with ERR LVL greater than or equal to 8 are
not, normally, accepted by the server. Therefore, while Examples #1 and #2 MUST be corrected PRIOR to
filing, the corrections needed for Example #3 should be performed, but are not necessary for the filing to be
accepted by the server.
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Although reports with ERR LVL less than 8 nay be accepted by the server, yoware advised to correct all errors
before uploading a report.

Note: You may use the validator at any tine during the data entry process. Locate errors and make corrections.
The following three error notices will also appear:

1. Filer’s Signature
2. Filing Date
3. Filer ID

These three errors refer to items that must be completed just prior to filing the report.

IMPORTANT: Once you file a report, this is an irretrievabl e action, and the information in the filed report
can not be altered in the future. Amending the “Filed Report” is your only option to correct an error.

Error Messages and Explanations

The following examples of error messages that you may receive during the validation process. The correct
procedure to remedy errors that your filing may receive is as follows:

> From the “failed diagnostics” window, chooseOK if you [1IRIEEIEYdERTNT I IR ) [ X |

are aware of the existing errors, and youwill be returned

to the Instructions Window so that you may navigate to Yourfiling contains validation errors.
the correct form in order to make necessary adjustments. *To return to the main menu and correct these errars,
click"OK"
> If you need more information to determine where errors

*Toview a description of the validation errars,

ist withi fili lect the Details button fq
exist within your filing, select the Details button for a click"Details"

listing of all detected errors. You may print this report,

if necessary, by choosing the print option. *To ignare these errors and continue filing,
click "Continue”.
> Again, selecting OK will return you to the Instru ctions
Window so that you nmay make necessary corrections in
order to validate your filing for upload.

Details Cortinue

[~ Always show details automatically

These errors can be tracked by referencing the form information, provided in the diagnostic report.

Error Message Explanation
Embedded double-quotes (“) not allowed Quotation marks within fields are not permitted [example, “Nickname”] and

should be removed before attempting to upload.
Parentheses [example, (Nickname)], may be used as a substitute.

Leading Blanks {e.g. “TEXT”} not allowed Character spaces before data within fields are not permitted (example Jones
) and should be removed before attempting to upload.

Invalid Amount format: When a field requires a numeric amount, only arabic numerals (1,2,3,4,etc.) will
be accepted.

Non-numeric data in Numeric Field When a field requires a numeric amount, only arabic numerals (1,2,3,4,etc.) will
be accepted.

{Field Number} is Required, but field is empty A required field has been left blank, and needs information in order to pass the
validation process. Refer to the form and file numbers to locate.

Error Messages/Explanations cont’d.
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Error Message

Explanation

Signatory {T }reasurer or {C}andidate ?

A form has not been signed, and needs authorized signatory in order to pass the
validation process.

Sup/Opp Code “_” Invalid (Valid Codes: S, O)

There is an invalid or non-entry where one is required.

Value given {_} is Invalid for this Field

An invalid entry has been performed, and should be remedied before attempting
to upload. (Example, substituting letters for numerals in a numeric field)

Conditionally Required field is Empty

A field that has become a “required field” based on information for this “filing”
has been left blank, and should have information entered before attempting to
upload.

Individual’s Last Name Not Given

Name information missing, and should be entered in full before attempting to
upload.

Street Address is Missing

Address information missing, and should be entered in full before attempting to
upload.

__not a valid 2-character USPS State Code

State code missing or invalid, and should be entered in full/correctly before
attempting to upload.

zip code is Invalid or Missing / Zip =

Zip code information is missing, and should be entered in full/correctly before
attempting to upload.

Filing Method

If you selected to continue, having made any necessary corrections, you should now see the Filing M ethod
Screen. The Filing Method Screen has four methods to select from:

> TCP/IP Selectif you have an activeSLIP/PPP (Internet) connection to the server that receives filings.
> Dialup Select if you would like to dial the server that receives filings directly.

> A: To download filing onto floppy disk in drive A.

> B: To download filing onto floppy disk in drive B.

If this is the first run of LALoad™, Filing Upload, click the Configure button to open the “Communications

Settings” screen.
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Filing Configure (Communication Settings)

The communications Settings screen is divided into four sections:

Upload Information
Upload Methods: Select TCP/IP if you have an active SLIP/PPP (Internet) connection to the server

that receives filings, or select Dial Up if you wouldlike to dial this server directly. Select drive A or
B to download the filing onto floppy disk.

TCP/IP host

Enter the name of the Internet server that receives the filings: WWW., ethics.state.la.us
Diskette

Select drive A or B to download filing onto floppy disk.
Dialup

Dialup filing is no longer available.

Although values must be entered in every field, The TCPAP host is not used ifthe upload method is ‘Dialup’.
Similarly, the Dialup prefix and Dialup no. are not used if the Upload method is ‘TCP/IP’.

Filer Information
E-mail

Enter an e-mail address to whichthe server can acknowledge a filing, e. g.you@se rver.com
Fax

Leave the FAX field blank.

Agency ID

Enter: LA

Dialup COM port settings

Port number
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Enter the number (e.g. 1,2,3,4 etc.) of a COM portto which a modem is connected. External nodems
are typically connected to COM 2; internal modems to COM3 or COM 4.

Baud Rate
Enter the modem speed in bps (e.g. 9600, 14400, 19200, 28800, 33600, 56000, etc)
Data bits, Parity and Stop bits

Select the appropriate values. The default setting are:

Data bits 8
Parity None
Stop bit 1

If you need help to upload using ‘Dialup’, and are not sure about setting up the COM port directly,
please call our Technical Support Staff for help.

Although values must be entered in every field, the Dialup COM port settings are not used if the
Upload method in the Upload section is TCP/IP.
After a filing method has been selected and your communication settings have been set up (you need only do
this once), click the OK button. This will bring up the Password/Filing ID screen.
Password/Filing ID

The Password/Filer ID screen has three edit fields:

> Password Enter the password assigned by the Louisiana Board of Ethics, by which thifiling
can be authenticated.

> Filer ID Enter the ID of the entity making this filing as assigned by the Board of Ethics.

> Previous ID If the current filing amends a previous filing, enter the ID of the previous filing.
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